May 2016 Release Notes

The Alma May release provides numerous new features and enhancements. Some of these enhancements are a result of the NERS or Idea Exchange initiatives.

Download a PDF of the Release Notes - Note that the PDF includes the online help pages that describe the core functionality of the new features.

Make the Most of This Release

<table>
<thead>
<tr>
<th>Action Items</th>
</tr>
</thead>
</table>

- **Idea Exchange:** [Customizing the Request Forms for Primo](#) - Request forms that are tailored for your end users' needs and exactly match the service options you suggest to your end users are definitely something that you will want to easily implement. The new Primo request form customization options allow you to do just that.

- **Requesting Copyright Agreement for Digitization Requests** - If your library, like so many other libraries, is required to make sure your patrons are aware of copyright restrictions when placing requests, you can now turn on the option to mandate a copyright declaration signature on the digitization request forms.
**Action Items**

- **Group Items or Loans by Library in User Notifications** - Notifications are now made clearer for patrons, with library separations implemented in the default notification templates. If you’ve customized your notifications, you can use the Alma default as an example for modifying your templates accordingly in order to achieve this goal.

- **Integration with UK Copyright Licensing Agency (CLA)** - If you are using the UK Copyright Licensing Agency’s Higher Education license, you can now verify your reading list citations’ compliance with the license terms in an integrated manner, by turning on this new integration option.

---

**What's New?**

The following sections present the new and changed features in this release of Alma.

---

**Acquisitions**

- **PO Line Dates and Related Invoice Lines Displayed When Adding an Invoice Line** - When viewing or adding invoice lines, you can now see the **To** and **From** dates of the attached continuous PO line and up to five other invoice lines attached to the PO line. This information is helpful for seeing if you already received an invoice for the latest coverage period.

---

**Resource Management**

- **Electronic Collection Bibliographic Records and URLs Added to the Community Zone** - Electronic collection level descriptive records (bibliographic records) describing the collections and electronic collection level URLs are being added to the Community Zone. As part of this development, URL override options are available for activated electronic collections.

- **Duplicate Title Analysis** - You can now generate a report that identifies duplicate bibliographic records in your catalog.

  Watch the [Duplicate Title Analysis](#) video

- **Authority Control Task List Enhancements** - The Authority Control Task List now includes the capability to edit records from the list, and you can use the **Expand** feature in the MD Editor to display additional authority headings details.

- **Additional Resource Management Enhancements**
Digital Resource Management

- **New Global Changes Job for Digital Representations** - A New Update Information job is now available to implement global changes to the representations in a set of digital titles.

- **Enhanced Support for SRU/SRW Protocol** - Additional schemas (for example, Dublin Core) are now supported for the SRU/SRW protocol.

- **Streamlined Digitization Workflow** - There is now a single workflow when processing a digitization request, regardless of whether the representation is remote.

- **Additional Digital Resource Management Enhancements**

Fulfillment

- **Idea Exchange: Customizing the Request Forms for Primo** - Non-mandatory fields may now be hidden from the patron's view for hold, booking, and digitization request forms in Primo.

- **Group Items or Loans by Library in User Notifications** - The Borrowing Activity report, overdue/lost items notification, loan receipts, and return receipts have been restructured to group notices by library.

- **Idea Exchange: Keyboard Shortcuts for Patron Services** - Returns, Pick from Shelf, Manage Patron Services, and Scan In Items may now be invoked from keyboard shortcuts.

- **Requesting Copyright Agreement for Digitization Requests** - It is now possible to require a patron to indicate that he or she has read a copyright agreement before submitting a Primo digitization request form.

- **Copyright Approval Enhancements** - There are additional fields for managing copyright clearance and enhancements to the Approval Requests List.

- **Integration with UK Copyright Licensing Agency (CLA)** - Alma can now retrieve real-time copyright licensing information for UK customers.

- **Viewing Electronic Resources for a Citation** - You can now see more information about linked electronic resources on the Edit Reading List page.

- **Additional Fulfillment Enhancements**
Resource Sharing

- **Lookup Agency for NCIP Partners** - Alma now supports the option to call the NCIP Lookup Agency function while configuring the partner. This is applicable only for NCIP peer-to-peer partners.

- **Create a Resource Sharing Request from Search** - It is now possible to place a resource sharing request from the repository search result, allowing creation of requests without accessing the task lists. Watch the [Create Resource Sharing Request from Search video](#).

- **Additional Resource Sharing Enhancements**

Collaborative Networks

- **Held By Indication for Electronic Collections** - Title searches in the Network Zone will now include the Held By indication for electronic collections available to members.

- **Distinguishing Between Network Level Local Authority Records and Institution Level Local Authority Records** - Improvements have been made in the MD Editor to distinguish between local authority records at the Institution and Network levels.

- **Browsing Bibliographic Headings in the Network** - Member institutions in a collaborative network environment can now browse the headings of the shared catalog managed in the Network Zone.

- **Enhancements to the Aleph Central Catalog Integration** - Enhancements have been made to the integration of Alma institutions with the Aleph Central Catalog—for example, the ability to indicate the merge routine to be used by Aleph when merging changes from a member institution into the Central Catalog.

Analytics

- **Source Type Added to Link Resolver Usage** - The Source Type field has been added to the OpenURL Context Details dimension of the Link Resolver Usage subject area.

**NOTE:** Due to an upgrade of the OBIEE used by Alma Analytics, the export option for reports from Alma Analytics to Excel 2003 will no longer be supported in a future release. Only export to an xslx format will be supported and not export to an xls format.
Alma Infrastructure

- You can generate a tracking ID that assists Ex Libris in debugging, by clicking the new Generate Tracking ID link from the Persistent Menu (Help > Generate Tracking ID). Use this option when an error occurs and the standard error message with a tracking ID does not appear automatically. Generate the ID as soon as possible after the error occurs. This ID enables Ex Libris to provide better initial analysis of the issues that you are encountering and helps identify inconsistent problems. Provide this ID in any Salesforce issue that you open. The following is an example of a tracking ID:

Please use this unique tracking ID when reporting an issue:
E08-0604133528-TE8IH-GENERAL

- In certain cases, an institution may have multiple SSO systems using the SAML protocol. In such cases, you can now configure multiple active SAML profiles in one institution. The Alma URL must contain the /SAML/idpCode/[profile code] suffix for Alma to use the correct SAML integration profile. To configure this feature, change the enable_multiple_active_saml_idp parameter (Administration > General Configuration > Configuration Menu > General Configuration > Other Settings) to true. For more information, see SAML-Based Single Sign-On/Sign-Off.

Alma APIs

- Idea Exchange: A new API was created to retrieve a job's status as well as the job's report, including detailed information such as successful records and failed records:

GET /jobs/
GET /jobs/{job id}
GET /jobs/{job id}/runs
GET /jobs/{job id}/runs/{run_id}

- The Expand parameter was added to the Get User Loans API. For details, see https://developers.exlibrisgroup.com/alma/apis/users.
Known Issues

- When importing an EOD file using the New Order profile, if the location of the item does not have a call number type, the call number type of the institution should be used as the alternative call number type. Currently, however, no alternative call number is used.

- Related to merging bibliographic records in the MD Editor, if there are no requests, the Merge Records and Combine Inventory pop-up window does not display a count of 0 (zero) requests. The count appears for requests only when it is greater than 0 (zero). The count should also appear as 0 (zero) requests when they occur.

- Regarding the autocomplete/pop-up assistance being provided for several UNIMARC fields in the MD Editor, there is a known issue related to UNIMARC 327 $a and 327 $b. These subfields are based on the same functionality and as a result, the pop-up suggestions in the MD Editor suggests both subfields’ values when entering content in either the 327 $a or the 327 $b.

- Fixed position fields cannot be modified using the extension loader (extension packs) at this time.

- When creating an OCLC Connexion import profile in a Network Zone member institution with the Use NZ option selected, the Use NZ record option is used upon finding a match. Currently, there is no possibility to select the Merge, Overlay, or Do not import options instead.

- When a record is deleted in Alma, the headings associated with the record are still available when browsing bibliographic headings.

- The Total electronic portfolios imported count in the MD import report does not take into account the portfolios imported in the first file that is imported when the import is split into several files.

- When creating an Analytics report using the Cost per Use field, the year used is taken from the date of the invoice transaction instead of the fiscal year of the fund used in the transaction.

Data Services

- More than 3800 Alma Community Zone records are now enriched with MARC records from OECD iLibrary.

- Library of Congress Authorities Community Zone Updates

- New Electronic Collections Added to the Alma CKB

- No new external search resources for added for this release.
PO Line Dates and Related Invoice Lines Displayed when Adding an Invoice Line

When viewing or adding invoice lines attached to continuous PO lines, you can now see:

- The To and From subscription dates of the associated PO line
- The last (up to five) invoice lines associated with this PO line.

This information is helpful for seeing if you already received an invoice for the latest coverage period.
Adding Invoice Line for Continuous PO Line

In addition, if the invoice line has a note, the note (or part of the note and a tooltip) appears in the invoice line list when viewing the PO line or the invoice.

Viewing Invoice Line for Continuous PO Line

Invoice Line List

For more information, see the marked areas in Creating an Invoice From a PO or Manually.
Resource Management - May 2016 Enhancements

Electronic Collection Bibliographic Records and URLs Added to the Community Zone

As described in the Community Zone Electronic Collections Enhanced with Collection-Level Bibliographic Record Content section of the Alma February 2016 Release Notes, bibliographic records (descriptive records) for electronic collections are being added to the Community Zone. In addition, URLs are being added to the electronic collections in the Community Zone with the option to specify a local override.

The addition of bibliographic records and URLs to the electronic collections provides an option to expose and provide access to electronic collections to patrons via the discovery system.

The bibliographic records and URLs will be updated in the Community Zone as part of the CKB update process.

These new electronic collection bibliographic records can be accessed by completing an Electronic Collection search from the Community tab in Alma's Repository Search and clicking the Descriptive Record link to open the electronic collection's bibliographic record.

See Repository Search Results Actions for more information.

From the MARC Record Simple View, you can copy the bibliographic record or link to it.
Electronic Collection Bibliographic Record from the Community Zone

In a Network environment, there is the additional **Copy to Network** option (see below).

Electronic Collection Bibliographic Record from the Community Zone in a Network Environment

When you activate an electronic collection from the Community Zone (see [Activating an Electronic Collection Using the Activation Wizard](#) for more information), the URL stored in the Community Zone for the electronic collection displays in the Electronic Collection Information section on the Activation Wizard page. To override this URL, enter a new URL in the **Electronic Collection Level URL** parameter.
Override the URL as Part of the Activation Process

As part of the activation process, you can also select a new bibliographic record for the Additional descriptive information parameter, and the Mark Bib as suppressed is selected as the default. If you choose not to mark the bibliographic record as suppressed, the bibliographic record is published to the discovery system and access to the electronic collection will be available through the Alma Link Resolver by directing the user to the electronic collection level URL.

Complete the remaining activation parameters as you normally would, and click Activate. The Electronic Service Editor page appears with a confirmation message of successful activation. Click Save to complete the process.
If you need to override an electronic collection URL for an electronic collection that you have activated, you can do that using the Electronic Collection Editor and specifying a new URL for the **Electronic Collection Level URL (override)** parameter.

The **Electronic Collection Level URL** parameter displays the URL from:
The URL identified in the Community Zone for the (activated) electronic collection

The URL identified for a completely local electronic collection (not activated from the Community Zone)

The **Electronic Collection Level URL (override)** parameter may contain the override to the URL stored in the Community Zone or the URL created for a completely local electronic collection.

For a local electronic collection, you can create and edit both the **Electronic Collection Level URL** parameter and the **Electronic Collection Level URL (override)** parameter in the Electronic Collection Editor.

![Electronic Collection Level URL Parameter for a Local Electronic Collection](image)

**NOTE:** During May 2016, the Community Zone will be updated with the electronic collection bibliographic record and URL content. For instances where you previously entered an **Electronic Collection Level URL** parameter for an electronic collection activated from the Community Zone, this parameter will be placed in the **Electronic Collection Level URL (override)** parameter as part of the migration to this new capability. Indexing of the **Electronic Collection Level URL** for advanced search access will be completed as part of the July full re-indexing process.

---

**Duplicate Title Analysis**

Duplicate Title Analysis enables the generation of a report that identifies duplicate bibliographic records in your catalog. Duplicates are determined by looking for a match on one of the following parameters:

- System Control Number (035 field) with or without a prefix such as (oclc)
- ISBN
Duplicate Title Analysis

After submitting a job, using Duplicate Title Analysis (Resource Management > Advanced Tools), the job results can be viewed from the History tab on the Monitor Jobs page (Administration > Manage Jobs > Monitor Jobs). The History tab can also be accessed from the Job History link on the Duplicate Title Analysis page.

Duplicate Title Analysis Job

For detailed information, see Using Duplicate Title Analysis.

**NOTE:** In a future release, additional capabilities will be provided for handling duplicate bibliographic records in batch mode.

---

Authority Control Task List Enhancements

The Authority Control Task List has been enhanced to include the capability to edit records from the list; and while editing these records in the MD Editor and viewing preferred/nonpreferred terms, you can use the **Expand** feature to display additional details.
Authority Control Task List Edit Option

Authority Control Task List MD Editor Expand Option

For detailed information, see Using the Authority Control Task List.

Additional Resource Management Enhancements

- Editing bibliographic records can be accomplished from within the Browse Bibliographic Headings function. When you click View in the Bibliographic Record Headings browse list, the split screen that opens with one or more bibliographic record provides the option to also edit bibliographic records. See Browsing Bibliographic Headings for more information.
Edit Bibliographic Records from the Browse Bibliographic Record Headings List

- Additional confirmation dialog boxes and error messages were added, and some error messages were enhanced, in response to clicking **Done** while managing electronic resource activation. For the complete list of messages, see the tables in **To mark a resources as done** in Managing Electronic Resource Activation.

- There is a new way of dealing with the period in normalization rules, which will greatly increase the possibilities for correcting data. Until now, it was not possible to deal with the period (replace it or use it as part of text to add). Now it is possible to specify the period by preceding it with four backslashes. For example, the rule below will remove the period (replace it with nothing) in 245 subfield a:

  ```
  rule "remove period in 245 subfield a (replace it with nothing) period is specified by preceding it with four backslashes"
  when (TRUE)
  then
      replaceContents "245.a.\\.\\.\\." with ""
  end
  ```

- When a contact email is present in a rule contributed to the Community Zone, the email is now a link that creates an email to the specified email address.
The permissions for the **Add/Remove Extensions** buttons in **Resource Management > Resource Configuration > Configuration Menu > Metadata Management**, for any MARC profile, were changed from Cataloger Extended to Catalog Administrator.

A new privilege, **LOCALIZE_SELECTED_PORTFOLIOS**, was added to the following roles by default: Catalog Administrator, Catalog Manager, Cataloger, Cataloger Extended, Collection Inventory Operator, Collection Inventory Operator Extended, Digital Inventory Operator, Digital Inventory Operator Extended, Electronic Inventory Operator, Electronic Inventory Operator Extended, Physical Inventory Operator, Physical Inventory Operator Extended, Purchasing Manager, Purchasing Operator, Receiving Operator, Receiving Operator Limited, Repository Administrator, Repository Manager, Selector, Trial Manager, Trial Operator. This privilege enables users with these roles to localize portfolios. If you do not want any of these roles to have this privilege, contact Ex Libris Support to disable the privilege.

A new privilege, **DELETE_BIB**, was added to the following roles by default: Catalog Administrator, Catalog Manager, Cataloger, Cataloger Extended, Collection Inventory Operator, Collection Inventory Operator Extended, Digital Inventory Operator, Digital Inventory Operator Extended, Electronic Inventory Operator, Electronic Inventory Operator Extended, Physical Inventory Operator, Physical Inventory Operator Extended, Purchasing Manager, Purchasing Operator, Receiving Operator, Receiving Operator Limited, Repository Administrator, Repository Manager, Trial Manager, Trial Operator. This privilege enables users with these roles to delete a bibliographic record if they are deleting the last item associated with the record.

Information about specific errors was added to the Publishing to OCLC - Bibliographic Records report page.

Hebrew language support is now available in the repository search and MARC Record Simple View.
<table>
<thead>
<tr>
<th>LDR</th>
<th>00433nam a2200133 u 4500</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>992164130000521</td>
</tr>
<tr>
<td>005</td>
<td>20121029125842.0</td>
</tr>
<tr>
<td>008</td>
<td>121029c2012 xx r 000 0 eng d</td>
</tr>
<tr>
<td>035</td>
<td>_a (OCoLC)</td>
</tr>
<tr>
<td>082</td>
<td>_a 022.248. Yool</td>
</tr>
<tr>
<td>100</td>
<td>_a Kortick, Yool jd 1971-</td>
</tr>
<tr>
<td>245</td>
<td>_aodate) location</td>
</tr>
<tr>
<td>660</td>
<td>_a Library science</td>
</tr>
<tr>
<td>660</td>
<td>_a Information science</td>
</tr>
</tbody>
</table>
New Global Changes Job for Digital Representations

A new job, Global Representation Changes, is now available to apply global changes to the representations in a set of digital titles.

To access this job:

1. On the Run a Job - Select Job to Run page (Administration > Manage Jobs > Run a Job), select Global Representation Changes and click Next.
2. Select a set of digital titles on which to run the job and click Next.

The following appears:
Run a Job - Enter Task Parameters

3. In the **Apply Only For** section, indicate the criteria to determine the representations for which you want the changes to apply. This will allow you to filter out representations you do not need to update.

4. In the **Change Fields** section, select the parameters to indicate the changes that you want to be made to the representations. For more information about the fields of this page, see [Adding a Representation](#).
5. Click **Next** and perform the rest of the steps for running a job as described in Running Manual Jobs on Defined Sets.

**NOTE:**
- All of the **Apply only for** parameters must match for a representation to be handled.
- The **Condition** drop-down list is available for the **Label** and **Public Note** fields. If a condition does not apply, only that specific field change is ignored, but the rest of the fields are changed.
- You can delete public notes by selecting the **Public Note** field and leaving it empty.

---

**Enhanced Support for SRU/SRW Protocol**

The following enhancements have been implemented for SRU/SRW support:

- Dublin Core format and all MARC schemas (including UNIMARC and CNMARC) are now supported for SRU/SRW. The following crosswalks are supported:
  - From DC and MARCXML to every other format (DC, MARCXML, CNMARCXML, KORMARCXML, and UNIMARCXML)
  - From every format (DC, MARCXML, CNMARCXML, KORMARCXML, and UNIMARCXML) to DC and MARCXML.
  - Crosswalks between CNMARCXML, KORMARCXML, and UNIMARCXML are not supported.
  - For more information, see the [Developers Network](#).

- For Dublin Core records with representations, the **DC identifier** field is added with a URL for each representation.

For more information on the SRU/SRW protocol, see [SRU/SRW Search](#).

---

**Streamlined Digitization Workflow**

There is now a single workflow when processing a digitization request, regardless of whether the representation is remote. Additionally, information from the digitization request is now transferred automatically to the Representation Details page to simplify creating the representation - for example, when digitizing a book chapter, the request details such as from/to pages are automatically transferred into the digital representation’s details, for enhanced delivery and management use. For detailed information, see [Adding a Digitization Profile Rule](#).
Additional Digital Resource Management Enhancements

- The patron-facing Alma Digital Viewer now supports multiple languages. For more information on the Alma Digital Viewer, see Viewing Digital Representations.

- A new privilege, VIEW_MANAGE_COLLECTION, was added to the following roles: Collection Inventory Operator, Collection Inventory Operator Extended, Digital Inventory Operator, Digital Inventory Operator Extended. This privilege enables users with these roles to view collections without being able to edit them. The existing privilege, COLLECTION_INVENTORY_MANAGE, was added to the Digital Operator in addition to the Collection Operator. This privilege enables editing a collection.

- Every collection-related operation is available only for users with a relevant role in the library of the collection.

- In publishing to Primo, the public note was added to the AVD on subfield f.
Fulfillment - May 2016 Enhancements

Customizing the Request Forms for Primo

For Primo, on the hold, booking, and digitization request forms, non-mandatory fields may now be hidden from the patron’s view. A new mapping table has been created for each of the request forms to define which fields are visible.

For detailed information about configuring the mapping tables, see Customizing Primo Request Forms.

Group Items or Loans by Library in User Notifications

Patron notifications that include lists of items from multiple libraries were restructured to delineate each library to make it easy for a patron to determine the libraries with which he or she has liabilities.

The affected notifications are:

- Borrowing Activity report
- Overdue/lost items notification
- Loan receipts
- Return receipts

The following are some example reports:
Dear Ex Libris,
We would like to remind you that you have the following items on loan:

### Overdue Loans

<table>
<thead>
<tr>
<th>Title</th>
<th>Due Date</th>
<th>Fine</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>The go-between</td>
<td>12/02/2013</td>
<td></td>
<td>Eugene McDermott Library</td>
</tr>
</tbody>
</table>

### Loans

<table>
<thead>
<tr>
<th>Title</th>
<th>Due Date</th>
<th>Fine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The go-between</td>
<td>12/02/2013</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Representing sport / Rod Brockes.</td>
<td>05/09/2016</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Ackerman Center

<table>
<thead>
<tr>
<th>Title</th>
<th>Due Date</th>
<th>Fine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jews and the Olympic Games : the clash between sps : with a complete review of Jewish Olympic medallists</td>
<td>04/12/2016</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sincerely,
Access and Delivery Services

UDT
Loan Receipt Letter

Implementor, Ex Libris

Eugene McDermott Library
800 West Campbell Road
UTD
Richardson
75080-3021
USA

03/22/2016

Dear Ex Libris,

The following items have been loaned from the library at the Eugene McDermott Library, Main Circulation Desk.

Loans:

<table>
<thead>
<tr>
<th>Title</th>
<th>Author</th>
<th>Loan date</th>
<th>Due date</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Representing sport : Rod Brookes.</td>
<td>Brookes, Rod.</td>
<td>03/22/2016</td>
<td>05/09/2016 23:59:00 CDT</td>
<td>Eugene McDermott Library</td>
</tr>
</tbody>
</table>

Ackerman Center

<table>
<thead>
<tr>
<th>Title</th>
<th>Author</th>
<th>Loan date</th>
<th>Due date</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jews and the Olympic Games : the clash between sport and politics : with a complete review of Jewish Olympic medallists</td>
<td>Taylor, Paul</td>
<td>03/22/2016</td>
<td>04/12/2016 18:00:00 CDT</td>
<td>Ackerman Center</td>
</tr>
</tbody>
</table>

Sincerely,

Access and Delivery Services

Eugene McDermott Library

Loan Receipts

Return Receipt Letter

Implementor, Ex Libris

Eugene McDermott Library
800 West Campbell Road
UTD
Richardson
75080-3021
USA

03/22/2016

Dear Ex Libris,

The following loans were returned to the library at the Eugene McDermott Library, Main Circulation Desk.

Loans:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Author</th>
<th>Due date</th>
<th>Return date</th>
<th>Fines</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Representing sport : Rod Brookes.</td>
<td></td>
<td>Brookes, Rod.</td>
<td>05/09/2016 23:59:00 CDT</td>
<td>03/22/2016 02:07:28 CDT</td>
<td></td>
<td>Eugene McDermott Library</td>
</tr>
</tbody>
</table>

Ackerman Center

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Author</th>
<th>Due date</th>
<th>Return date</th>
<th>Fines</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jews and the Olympic Games : the clash between sport and politics : with a complete review of Jewish Olympic medallists</td>
<td></td>
<td>Taylor, Paul</td>
<td>04/12/2016 18:00:00 CDT</td>
<td>03/22/2016 02:07:22 CDT</td>
<td></td>
<td>Ackerman Center</td>
</tr>
</tbody>
</table>

Sincerely,

Access and Delivery Services

Eugene McDermott Library

Return Receipts
Using XSL to customize the Borrowing Activity report is explained in Configuring Alma Letters. If the XSL was previously customized, it will not be updated to include the details by library. Restore the XSL to the default in order to take advantage of this enhancement.

### Keyboard Shortcuts for Patron Services

Keyboard shortcuts were assigned to the following commonly used tasks:

- **Alt+R** - Returns
- **Alt+P** - Pick from Shelf
- **Alt+W** - Manage Patron Services
- **Ctrl+Alt+S** - Scan In Items

**NOTE:** You must be at a circulation location for the above shortcuts to work.

To view a more complete list, see Alma Global Hotkeys.

### Requiring Copyright Agreements for Digitization Requests

It is now possible to require that a patron indicate that he or she has read a copyright agreement before submitting a Primo digitization request form.

The Copyrights table was renamed Copyright Declaration and contains a new file to configure - DigitizationRequestCopyrightDeclaration.html - which is the Digitization Request Copyrights Declaration that appears above the check box in the Primo Get It form. The patron can click Request only after selecting the check box indicating agreement.

In Alma, the check box Copyright Declaration Signed by Patron appears on the patron digitization request form. See Creating a Request.

The Approval Requests List indicates whether the copyright declaration was signed. See Approving/Rejecting Requests for Digitization.

The checkbox in Primo, as seen below, only appears once the Digitization Request Copyrights Declaration has been customized.
Copyright Approval Enhancements

- Additional fields for managing copyright clearance were added to the staff digitization request when creating a request on a physical resource or adding a reading list citation. For a description of the new fields, see Creating a Request.

- When a request requires approval (as indicated by a digitization profile rule, or if the fields were entered when adding a reading list citation), a copyright clearance approval task is created and is available to manage on the newly reorganized Approval Requests List (see the previous feature and Approving/Rejecting Requests for Digitization). The reorganized page includes a new filter, Activity Status.

- When adding or editing a citation, you can choose to save your changes and then immediately view the Approvals Requests List using the new Save and Manage Approval button. For more information, see Adding Citations to a Reading List.

- The digitization profile rules now include a new value, Course Related Digitization, when you select Request Type as an input parameter. This value can be used to create a rule that creates an Approval task when a
reading list citation is submitted. For information on digitization profile rules, see Configuring Digitization Profiles Rules.

- Two new statuses were added to the Citations Copyright Default Status table (see Configuring the Default Copyright Status of Reading List Citations):
  - **Waiting for Approval** - Assigned automatically to a citation when there is a new copyright clearance approval task for it.
  - **Waiting for CC** - Assigned manually to indicate that a librarian is working on the copyright clearance task.

---

**Integration with UK Copyright Licensing Agency (CLA)**

Alma can now retrieve real-time copyright licensing information for UK customers. When enabled:

- To view CLA copyright information about a reading list citation, click Check CLA Permissions on the Edit Reading List page. For more information, see the marked area in Managing Citations.
- To enter CLA-specific information about a source in a digitization request, select an option in the Source field. For more information, see the marked area in Creating a Request.

To enable CLA, set display_CLA_info_in_alma to true; see Configuring Other Settings.

---

**Viewing Electronic Resources for a Citation**

You can now see more information about linked electronic resources on the Edit Reading List page (for more information, see marked areas of Managing Citations):

- To view the original source (the URL) of a citation added using Leganto Cite It, click View Source. This link appears for citations that have a non-empty Source field.
- To view the OpenURL link resolver results for an article, click View It. This link will appear if the system can resolve the citation's metadata to an electronic resource.

---

**Additional Fulfillment Enhancements**

- A validation for library code was added to the Primo View To Libraries mapping table to verify that the library code exists.
- The course loader integration profile now includes additional parameters to support overwriting existing information for a course. In addition, support was added for course "rollover": new courses that inherit the
reading lists and other information from old courses. For more on the changes to the course loader integration profile, see the Leganto May 2016 release notes.

- **NotificationUponRenewalLetter** was changed to **NotifyUponRenewalLetter**.

- In the XML output of the Bursar integration profile, the new field **itemInternalLocation** holds the internal location of the fine/fee related item. The **itemLocation** field continues to hold the external location, or the internal location if there is no defined external location.

- A newly created loan's status is **Loan** (this was always true). **Loan** is now an available option in the Overdue and Lost Loan Record Profile. You can now, for example, select **Loan** as **Loan Status** and set **Days After Status Date** to 5 to find all loans that are five days old.

- The delivery address (at home or at work) can now be written in the loan receipt letter when configuring it in the XSL.
Lookup Agency for NCIP Partners

Alma now supports the option to call the NCIP Lookup Agency function while configuring the partner. This is applicable only for NCIP peer-to-peer partners.

To view the partner's information, click the new **Lookup Agency** button on the partner parameter page. Clicking this button contacts the partner and returns their supported protocol or other information the partner wishes to transmit to assist in the partner configuration process.
Lookup Agency Response

To set your institution's information that will be transmitted to other partners, enter the protocol or other information into the value of the `resource_sharing_protocol` parameter of the Fulfillment mapping table. For information on modifying this value, see Configuring Other Settings. The complete list of NCIP peer-to-peer parameters is on the Resource Sharing Request page.

Create a Resource Sharing Request from Search

It is now possible to place a resource sharing request from the repository search result, allowing creation of requests without accessing the task lists. This link is displayed automatically for staff with Fulfillment Services roles in the resource sharing library. The link appears on all item searches except collection, electronic collection, and authorities. See Searching in the Repository.
Additional Resource Sharing Enhancements

- Bibliographic data may now be sent in the NCIP ShipItem message. This may be used in cases where an NCIP partner lends an item that doesn't exactly match the original request and you want to include the bibliographic data to specify what is being sent. For more information about the ShipItem message, see the Developer's Network.

- For NCIP peer-to-peer partners, resource sharing requests that include the Other System ID, DOI, or Barcode fields now also include this information in the NCIP message. For more information, see the Developer's Network.

- A new check box, **Ignore electronic resources**, has been added to lending section of the definition of the resource sharing library. If it is checked, the lending locates (manual and automatic) will disregard electronic items.
Collaborative Networks - May 2016 Enhancements

Held By Indication for Electronic Collections

Title searches in the Network Zone will now include the Held By indication for electronic collections available by members.

With the addition of electronic collection level bibliographic record content available in the Community Zone (see Electronic Collection Bibliographic Records and URLs Added to the Community Zone), the Network Zone will be updated with the electronic collection bibliographic records for those electronic collections that have been activated from the Community Zone by the network members. As a result, the search results for All Titles searches performed by members in the Network tab will include the Held By indication for electronic collections.

**NOTE:** Changes to the Network Zone will occur during May 2016 to include the electronic collection level bibliographic record content.

Distinguishing Between Network Level Local Authority Records and Institution Level Local Authority Records

For member institutions that are configured for working with local authorities, improvements have been made in the MD Editor to enable you to more easily distinguish between local authority records at the Institution and Network levels. This is apparent from the labeling changes and addition of icons in the MD Editor Records tab and in the File > New menu options.
MD Editor Records Tab for a Member in the Network
In the MD Editor Records tab of a member, the Network level local authority record is identified by *(Network)* in the name. In the MD Editor *File > New* menu of a member, the Institution and Network level local authority record options are identified with the Institution and Network icons.

Since you identify the level of the local authority (Institution or Network) when you select the *File > New* option, it is no longer necessary to set the *File > Options* to indicate the placement of new local authority records. As a result, this option has been removed from the *File > Options* menu.
For more information, see [Working with Authority Records](#).

## Browsing Bibliographic Headings in the Network

Browse Bibliographic Headings, available in the April 2016 release, has been expanded to include browsing the headings of the shared catalog managed in the Network Zone for member institutions in a collaborative network environment. For member institutions in such an environment, you can select where you would like to browse using the **Browse In** parameter. The options are to browse the titles at the institution level (**Institution**) or browse the titles at the Network level (**Network***).

For more information, see [Browsing Bibliographic Headings](#).

## Enhancements to Aleph Central Catalog Integration

The following enhancements were implemented to Alma integration with the Aleph Central Catalog:

- **Central Catalog Merge Routine** field has been added to the Central Catalog Integration publishing profile. This indicates the merge routine to be used by Aleph when merging changes from a member into the central catalog and allows the central catalog to support variant handling of local fields:
Central Catalog Merge Routine

Enhancements have been made to the Central Catalog Integration job history report, including the addition of the Record not deleted - record ID does not exist information.

For more information, see Integration of the Aleph Central Catalog.
Analytics - May 2016 Enhancements

Source Type Added to Link Resolver Usage

The **Source Type** field has been added to the OpenURL Context Details dimension of the Link Resolver Usage subject area. This field allows libraries to easily gather data about where users are coming from when using the Alma Link Resolver.

The following are the possible values for the **Source Type** field:

- **Alma** - The link was clicked from within Alma staff user interface.
- **Primo and Primo Central** - The link was clicked from Primo or Primo Central.
- **The source** - When the link is clicked from another source, such as Web of Science, Ebsco, Pubmed, Google Scholar, or any other external source, the name of the source is used as the source type.

The following is an example of a report using the **Source Type** field:
<table>
<thead>
<tr>
<th>Source</th>
<th>Source Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMS:MathSciNet</td>
<td>AMS:MathSciNet</td>
</tr>
<tr>
<td>Unknown</td>
<td>Alma</td>
</tr>
<tr>
<td>info:sid/primo.exlibrisgroup.com</td>
<td></td>
</tr>
<tr>
<td>EBSCO:L'Année philologique</td>
<td>EBSCO:L’Année philologique</td>
</tr>
<tr>
<td>EBSCO:Library Literature</td>
<td>EBSCO:Library Literature</td>
</tr>
<tr>
<td>EBSCO:Philosophers Index with Full Text</td>
<td>EBSCO:Philosophers Index with Full Text</td>
</tr>
<tr>
<td>EBSCO:SPORTDiscus</td>
<td>EBSCO:SPORTDiscus</td>
</tr>
<tr>
<td>EBSCO:Women’s Studies International</td>
<td>EBSCO:Women’s Studies International</td>
</tr>
<tr>
<td>Elsevier:Reaxys</td>
<td>Elsevier:Reaxys</td>
</tr>
<tr>
<td>Entrez:PubMed</td>
<td>Entrez:PubMed</td>
</tr>
<tr>
<td>OVID:medline</td>
<td>OVID:medline</td>
</tr>
<tr>
<td>aip_journals</td>
<td></td>
</tr>
<tr>
<td>annual_reviews</td>
<td>Primo/Primo Central</td>
</tr>
<tr>
<td>apa_articles</td>
<td></td>
</tr>
</tbody>
</table>

**Source Type Report**

For more information, see [Open URL Context Details](#).
Data Services - May 2016

The Alma April Central KnowledgeBase and Community Zone package was applied to the Alma environments.

Library of Congress Authorities Community Zone Updates

The following are the Library of Congress Subject authority updates for the period of March 24th through April 20th:

- Number of records updated: 78
- Number of records added: 116
- Number of records deleted: 9

The following are the Library of Congress Name authority updates for the period of March 24th through April 20th:

- Number of records updated: 19808
- Number of records added: 12003
- Number of records deleted: 554

The following are the Canadian name authority file updates for the period of March 24th through April 20th:

- Number of records added: 916

The following are the MeSH updates for the period of March 24th through April 20th (includes the MeSH 2016 update):

- Number of records updated: 11710
- Number of records added: 8519
- Number of records deleted: 9255

The following are the Library of Congress Genre/Form Terms (LCGFT) updates for the period of March 24th through April 20th:

- Number of records updated: 4
- Number of records added: 2
- Number of records deleted: 7
New Electronic Collections Added to the Alma CKB

The following collections were added to the Alma Community Zone from March 28, 2016 until April 24, 2016:

- Association For Computing Machinery Digital Library 2015-2018
- Independent Scholarly Publishers Group 2016-2018
- BIBSAM Kluwer Law Journals 2016-2018
- BIBSAM Mark Allen Healthcare Journals 2016-2018
- BIBSAM Royal Society Of Chemistry Gold Excl Archive 2015-2017
- BIBSAM Royal Society Of Chemistry Gold Incl Archive 2015-2017
- BIBSAM Universitesforlaget Idunn.no Journals 2016
- BIBSAM Wiley Database Model 2016-2018
- Bloomsbury Collections: Anthropology 2015
- Bloomsbury Collections: Biblical Studies 2015
- Bloomsbury Collections: Bloomsbury Open 2015
- Bloomsbury Collections: C.H. Beck Hart Nomos 2015
- Bloomsbury Collections: Classical Studies & Archaeology 2015
- Bloomsbury Collections: Education 2015
- Bloomsbury Collections: Film & Media Studies 2015
- Bloomsbury Collections: Hart Publishing 2015
- Bloomsbury Collections: History 2015
- Bloomsbury Collections: Linguistics 2015
- Bloomsbury Collections: Literary Studies 2015
- Bloomsbury Collections: Philosophy 2015
- Bloomsbury Collections: Politics & International Relations 2015
- Bloomsbury Collections: Religious Studies 2015
- Bloomsbury Collections: Theology 2015
- Ebook Cental
- IEEE Xplore Bell Labs Technical Journal
- IEEE Xplore Communications Library
- IEEE Xplore Computing Library
- IEEE Xplore Conference Library Plus
IEEE Xplore Conference Proceedings Archive
IEEE Xplore Enterprise
IEEE Xplore IBM Journal of Research and Development
IEEE Xplore Journal of Systems Engineering and Electronics
IEEE Xplore Journals Archive 1884-1954
IEEE Xplore Journals Archive 1884-1999
IEEE Xplore Journals Archive 1955-1964
IEEE Xplore Journals Archive 1965-1974
IEEE Xplore Journals Archive 1975-1984
IEEE Xplore Journals Archive 1985-1994
IEEE Xplore Journals Archive 1995-1999
IEEE Xplore Journals Library Plus
IEEE Xplore MIT Press eBooks 2012
IEEE Xplore MIT Press eBooks 2012 & Prior
IEEE Xplore MIT Press eBooks 2013
IEEE Xplore MIT Press eBooks 2014
IEEE Xplore MIT Press eBooks 2015
IEEE Xplore MIT Press Journals Library: Computing & Engineering Collection
IEEE Xplore Morgan & Claypool Synthesis eBooks Library
IEEE Xplore Power & Energy Library
IEEE Xplore SMPTE Conferences
IEEE Xplore SMPTE Digital Library
IEEE Xplore Tsingua Science and Technology
IEEE Xplore Wiley eBooks 2010 & Prior (IEEE Xplore)
IEEE Xplore Wiley eBooks 2010 (IEEE Xplore)
IEEE Xplore Wiley eBooks 2011 (IEEE Xplore)
IEEE Xplore Wiley eBooks 2012 (IEEE Xplore)
IEEE Xplore Wiley eBooks 2013 (IEEE Xplore)
IEEE Xplore Wiley eBooks 2014 (IEEE Xplore)
IEEE Xplore Wiley eBooks 2015 (IEEE Xplore)
IEEE Xplore Wiley eBooks Library (IEEE Xplore)
IEEE/IET Electronic Library (IEL)
New External Search Resources

No new external search resources were added for this release.
Using Duplicate Title Analysis

New for May!

**PERMISSIONS:** To work with Duplicate Title Analysis, you must have one of the following roles:

- Cataloger
- Catalog Manager
- Catalog Administrator
- General System Administrator
- Approving Manager
- Approving Operator
- Editor Full
- Producer Manager
- Technical Analyst
- Repository Manager
- Arranging Manager
- Preservation Analyst
- Preservation Manager
- Arranging Operator
- Assessing Manager
- Assessing Operator
- Depositing Administrator

With Duplicate Title Analysis, you can run a job to create a report that identifies duplicate bibliographic records. Duplicates are determined by looking for a match on one of the following parameters:

- System Control Number (035 field) with or without a prefix such as (oclc)
- ISBN
Duplicate Title Analysis

After submitting a job, using Duplicate Title Analysis (Resource Management > Advanced Tools), the job results can be viewed from the History tab on the Monitor Jobs page (Administration > Manage Jobs > Monitor Jobs). The History tab can also be accessed from the Job History link on the Duplicate Title Analysis page.

To run a Duplicate Title Analysis job:

1. Open the Duplicate Title Analysis page (Resource Management > Advanced Tools > Duplicate Title Analysis).

2. Select one of the following options for matching duplicate bibliographic records:
   - System Control Number / Prefix
     The System Control Number parameter uses the MARC 21 035 field for determining a match. In addition, a prefix such as (oclc) contained in the 035 field can be specified to narrow the criteria used for matching on the 035 field. The Prefix field is optional.
   - ISBN
   - ISSN
Other Standard Identifier

The Other Standard Identifier parameter uses the MARC 21 024 field for determining a match.

3. Click **Submit**. The Running tab opens on the Monitor Jobs page showing the job status of Running (or Pending depending on activity in the jobs queue).

4. Select the **History** tab to view the job results when the job has completed running.

5. For the Duplicate Title Analysis job that you ran, select **Actions > Report** to open the Job Report page.
6. In the Counters section, click the link to open the Duplicate Titles Report in Excel .csvs format.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Group Number</td>
<td>MMSID</td>
<td>Identifier</td>
<td>Title</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>931056830000541</td>
<td>30842485</td>
<td>Scene design and stage lighting /</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>9312185100000541</td>
<td>30842485</td>
<td>Scene design and stage lighting /</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>9311701600000541</td>
<td>30796407</td>
<td>Essays on the Civil War and Reconstruction.</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>9311314800000541</td>
<td>30796407</td>
<td>Essays on the Civil War and Reconstruction.</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>939736200000541</td>
<td>60582677</td>
<td>Challenging nature : science in a spiritual world /</td>
</tr>
<tr>
<td>7</td>
<td>3</td>
<td>931231100000541</td>
<td>60582677</td>
<td>Challenging nature : science in a spiritual world /</td>
</tr>
</tbody>
</table>

**Duplicate Title Analysis Report in Excel .csvs Format**

The report provides the following columns of information:

- Group Number
- MMS ID
- Identifier
- Title
- Records in Group

Matching bibliographic records are identified by the same group number in the Group Number column. The value in the Identifier column is the value upon which the system found a match from the field that was selected for **Detect duplication based on** in your Duplicate Title Analysis job.
Using the Authority Control Task List

PERMISSIONS: To use the Authority Control Task List, you must have one of the following roles:

- Cataloger
- Catalog Manager
- Catalog Administrator

The Authority Control Task List provides more details regarding authority record updates and the authority control process that are relevant to the institution's bibliographic record headings.

The Authority Control Task List makes it easier to manage cataloging maintenance tasks. Specifically, this list highlights authority headings updates that require manual intervention. The following is a list of changes highlighted in the Authority Control Task List, some of which may require manual intervention due to a linking issue, a preferred-term correction issue, or deleted/updated authority record:

- Linking – Bibliographic heading found no matching authority heading
- Linking – Bibliographic heading found multiple matching authority headings

  This issue may occur as a result of times, for example, when the Library of Congress splits one subject heading into two subject headings such as Nurses and nursing is split and replaced with Nurses and Nursing. It may also occur when the system finds a Community Zone authority record and a local authority record match.

- Linking – Bibliographic heading linked to an authority record
- Preferred term correction – Bibliographic heading updated
- Preferred term correction – Bibliographic heading found no authorized term
- Authority record deleted – Unlinked the bibliographic heading
- Authority record updated

From the Authority Control Task List page, you can choose to view the tasks from the Review tab or the All tab. The Review tab contains a list of all the tasks that require some action, and the All tab displays all the tasks that have not yet been dismissed.

These lists can be filtered by date or by the type of action/change.
For successfully linked headings, there is an **Other Settings** configuration parameter, `authority_control_link_available`, that you may use to indicate if you want to view this information in the **All** tab of the Authority Control Task List page. See [Configuring Other Settings](#) for more information.

For more information, see the [Authority Control Task List](#) video (1:37 min.).

**NOTE:** You may find it helpful to use the MMS Creation Date index in the Authorities Advanced Search when working with authority records in the Authority Control Task List. For example, using this search index, you can view a list of new authority records that have been loaded. See [Using the Advanced Search](#) for more information.

To view tasks in the Authority Control Task List:

1. Open the Authority Control Task List page ([Resource Management > Cataloging > Authority Control Task List](#)).

2. Filter by **Submit Date** or **Action** to view the tasks upon which you want to focus.
The Review tab provides the following Action options:

- **Linking - BIB heading found no matching AUT headings**
  This option references attempts to find a link between a heading in the bibliographic record and an authority headings record. When no matching authority headings record is found, you may want to review the information in the bibliographic record.

- **Linking - BIB heading found multiple matching AUT headings (ambiguous)**
  This option references attempts to find a link between a heading in the bibliographic record and an authority headings record. In some cases, multiple matches are found. You need to review the possible matches to decide which is the correct one.

- **Preferred Term Correction - BIB heading found no authorized term**
  This option references updates to the bibliographic record with the value of the preferred term of the linked authority record. When the linked authority record does not have a preferred term matching the nonpreferred term (such as when the nonpreferred term is registered in the 410 field and the preferred term is in the 100 field), the bibliographic record is not updated.
The All tab provides the following Action options in addition to the ones described above for the Review tab:

- **Linking - BIB heading linked to AUT record**
  This options references attempts to find a link between a heading in the bibliographic record and an authority headings record. When a link is formed between a bibliographic heading and an authority record, an entry is created in the task list to show the information of the linked headings.

- **Preferred Term Correction - BIB heading updated**
  This option references updates to the bibliographic record with the value of the preferred term of the linked authority record. When this action is successful, the entry shows the value of the bibliographic record before and after the change.

- **AUT record deleted - Unlinked BIB heading**
  When an authority record is deleted, it is unlinked from the bibliographic headings it used to match. An entry for each such link shows the link prior to its deletion.

  **NOTE:** The task list shows entries only for deleted authorities that were linked to a bibliographic headings record in the institution. It does not show entries for authority records that were deleted but were not linked to a bibliographic headings record in the institution.

- **AUT record updated**
  For this option, Alma shows information on the updated authority record.

  **NOTE:** The task list shows entries only for updated authority records that were linked to a bibliographic headings record in the institution. It does not show entries for authority records that were updated but were not linked to a bibliographic headings record in the institution.

3. On the **All** tab, you can also choose to limit your view to certain columns by using the **Columns** drop-down list to make selections.

4. From the list, click a title link (from the Title column) to view a record.
While reviewing the list, sometimes you may notice that the same record (MMS ID) may be identified with two different errors. This may be caused by the system checking the Community Zone authority records and also checking local authority records for a match.

The title opens in the MARC Record Simple View page from which you can optionally click Edit to make any changes.
5. When you have completed your review and/or change, use the Actions > Dismiss option to remove a task from the list. You may also choose to dismiss multiple records by selecting the row check box in the check box column, choosing Dismiss Selected, and clicking Execute.

New for May!

To edit tasks and process changes with the Authority Control Task List:

1. Open the Authority Control Task List page (Resource Management > Cataloging > Authority Control Task List).

2. Select Actions > Edit for the task that you want to edit. Optionally, you may choose to edit multiple records by selecting the row check box in the check box column, choosing Edit Selected, and clicking Execute.
Authority Control Task List Edit Action

The record is opened in the MD Editor to the field that has the issue and highlights that field with the green background color. If there are additional fields in the record with issues, they are also highlighted in green.

Field with the Issue Opened in the MD Editor

3. Edit the record as you normally would.

When you use F3 to view preferred/nonpreferred terms, there is an **Expand** option that you can use to display
additional details for nonpreferred terms. The additional details are highlighted in bold and can be especially helpful when the nonpreferred terms are similar.

Display of Preferred/Nonpreferred Terms

Expanded Display with Additional Details for Nonpreferred Terms

4. Save your changes.
5. From the Authority Control Task List page when you are finished with the task(s), select the **Actions > Dismiss** option. You may also choose to dismiss multiple records by selecting the row check box in the check box column, choosing **Dismiss Selected**, and clicking **Execute**.
Working with Electronic Collection Bibliographic Records and URLs Added to the Community Zone

New for May!

Bibliographic records (descriptive records) for electronic collections and URLs are available in the Community Zone. The addition of bibliographic records and URLs to the electronic collections provides an option to expose and provide access to electronic collections to patrons via the discovery system. The bibliographic records and URLs are updated in the Community Zone as part of the CKB update process.

The electronic collection bibliographic records can be accessed by completing an Electronic Collection search from the Community tab in Alma’s Repository Search and clicking the Descriptive Record link to open the electronic collection’s bibliographic record.

Descriptive Record Link in the Community Zone Electronic Collection Search Results

See Repository Search Results Actions for more information.

From the MARC Record Simple View, you can copy the bibliographic record or link to it.
Electronic Collection Bibliographic Record from the Community Zone

In a Network environment, there is the additional **Copy to Network** option (see below).

Electronic Collection Bibliographic Record from the Community Zone in a Network Environment

When you activate an electronic collection from the Community Zone (see Activating an Electronic Collection Using the Activation Wizard for more information), the URL stored in the Community Zone for the electronic collection displays in the Electronic Collection Information section on the Activation Wizard page. To override this URL, enter a new URL in the **Electronic Collection Level URL** parameter.
Override the URL as Part of the Activation Process

As part of the activation process, you can also select a new bibliographic record for the Additional descriptive information parameter, and the Mark Bib as suppressed is selected as the default. If you choose not to mark the bibliographic record as suppressed, the bibliographic record is published to the discovery system and access to the electronic collection will be available through the Alma Link Resolver by directing the user to the electronic collection level URL.

Complete the remaining activation parameters as you normally would, and click Activate. The Electronic Service Editor page appears with a confirmation message of successful activation. Click Save to complete the process.
If you need to override an electronic collection URL for an electronic collection that you have activated, you can do that using the Electronic Collection Editor and specifying a new URL for the Electronic Collection Level URL (override) parameter.

The Electronic Collection Level URL parameter displays the URL from:
The URL identified in the Community Zone for the (activated) electronic collection

The URL identified for a completely local electronic collection (not activated from the Community Zone)

The **Electronic Collection Level URL (override)** parameter may contain the override to the URL stored in the Community Zone or the URL created for a completely local electronic collection.

For a local electronic collection, you can create and edit both the **Electronic Collection Level URL** parameter and the **Electronic Collection Level URL (override)** parameter in the Electronic Collection Editor.

**NOTE:** During May 2016, the Community Zone will be updated with the electronic collection bibliographic record and URL content. For instances where you previously entered an **Electronic Collection Level URL** parameter for an electronic collection activated from the Community Zone, this parameter will be placed in the **Electronic Collection Level URL (override)** parameter as part of the migration to this new capability. Indexing of the **Electronic Collection Level URL** for advanced search access will be completed as part of the July full re-indexing process.
Configuring Copyright Declarations

You can configure a copyrights statement for digital resources. This statement can be associated with an access rights policy to be displayed to patrons before they can view a digital resource. The DigitizationRequestCopyrightDeclaration form is displayed on the digitization request form. The resourceSharingCopyrights form is displayed on the resource sharing request form.

To configure copyrights:

1. From the Alma Main Menu (Fulfillment > Fulfillment Configuration > Configuration Menu > Digital Fulfillment), click Copyright Declaration. The following appears:

![Copyrights List](image)

**Copyrights**

Sample copyrights statements are available for you to customize.

2. Click Customize for a copyrights statement. The following, for example, appears:
3. Edit the copyrights statement, if you want, and click **Customize**.

After you edit a copyrights statement the following actions are available:

- **Edit** – Edit the copyrights statement
- **Restore** – Restore the copyrights statement to the default
- **View Default** – View the default copyrights statement

**New for May!** The sample shown above is the Digitization Request Copyrights Declaration. Entering content on this form will cause a checkbox to appear in Primo, asking the patron to confirm that they have read the copyright agreement before submitting a Primo digitization request form.
Configuring Electronic Document Delivery Rules

**PERMISSIONS:** To configure electronic document delivery rules, you must have one of the following roles:

- General System Administrator
- Fulfillment Administrator

Electronic document delivery rules provide functionality that enables libraries to take portions of a resource and make digital copies of that portion only. These rules define the conditions under which libraries can perform this function.

Each electronic document delivery rule can be either enabled or disabled. By default, each new rule is enabled.


**Electronic Document Delivery Rules List Page**

**NOTE:** Electronic document delivery rules can be configured at the institution level only. Select the institution from the **You are configuring** filter on the Fulfillment Configuration page.

The following actions can be performed on this page:

- Add electronic document delivery rules (see Adding Electronic Document Delivery Rules)
- Edit electronic document delivery rules (see Editing Electronic Document Delivery Rules)
- Duplicate electronic document delivery rules (Actions > Duplicate and modify the relevant fields)
- Delete electronic document delivery rules (Actions > Delete)
- Disable electronic document delivery rules (click the yellow check mark 🏷 to the left of the electronic document delivery rule. To enable a disabled electronic document delivery rule, click the gray check mark ✅ to the left of the electronic document delivery rule.)
**Adding Electronic Document Delivery Rules**

The electronic document delivery rules that you define apply to all libraries within the institution.

Each electronic document delivery rule can be either enabled or disabled. By default, each new rule is enabled.

**To add a new electronic document delivery rule:**


   **NOTE:** If you want to create a copy of an existing electronic document delivery rule, select **Actions > Duplicate**. Once you have copied the rule, you can modify it as needed.

2. In the **Electronic Document Delivery Rules Editor** section, specify a name (required) and description (optional) for the new rule.

3. In the **Input Parameters** section, specify the components of the input parameter (Name, Operator, and Value). A set of input parameters may look like this: **User group = Graduate student** or **Inventory owner = Art Library**.

4. Click **Add Parameter**. The set of input parameters is added to the list of parameters for the electronic document delivery rule.

5. Repeat the previous two steps to add all the required parameters for the rule.

   **NOTE:** All the input parameters must be fulfilled in order for the rule to be applied. If not all the input parameters are fulfilled, the default electronic document delivery rule will be applied.
6. In the **Output Parameters** section, select whether electronic document delivery should (**True**) or should not (**False**) be allowed.

7. Click **Save** to store the new rule.

---

**Electronic Document Delivery Rules List Page**

8. If you have defined more than one rule, on the Electronic Document Delivery Rules List page, use the **Move Up** and **Move Down** arrows to set the order of the rules. The order of the rules is important, as the system applies the first (and only the first) appropriate, enabled rule.

---

**Editing Electronic Document Delivery Rules**

You can edit the default electronic document delivery rule or a digitization profile rule that you added.

**To edit electronic document delivery rules:**

1. On the Electronic Document Delivery Rules List page (**Fulfillment > Fulfillment Configuration > Configuration Menu > Digital Fulfillment > Electronic Document Delivery Rules**), select **Actions > Edit** for the electronic document delivery rule that contains the input parameters you want to update, or click the **Edit** link under **Default Rule** to update the default electronic document delivery rule. The Electronic Document Delivery Rules Editor page appears.

2. Modify the rule name and description as required.

   **NOTE:**

   - You cannot edit an existing set of input parameters. To modify an existing set of input parameters, first delete the existing set, and then add a new set.
   - You cannot delete or add a new set of input parameters for the default rule.

3. Click **Delete** for the specific set of input parameters record you want to delete.

4. Add a new set of input parameters, as described in **Adding Electronic Document Delivery Rules**.

5. In the **Output Parameters** section, select whether electronic document delivery should (**True**) or should not (**False**) be allowed.
6. Click **Save** to store your changes to the electronic document delivery rule.

The default rule has no configuration parameters and can only be activated (**True**) or deactivated (**False**), as follows:

- **True** – Indicates that if no electronic document delivery rule is met, the document is still sent.
- **False** – Indicates that if no electronic document delivery rule is met, the document is not sent.
2. Enter the Primo view name and the Alma library code which will appear in the filtered view. A new row may be added for each library that will appear in a Primo view.

3. Click **Customize**.

---

**New for May!** Customizing Primo Request Forms

**PERMISSIONS:**

To configure the displayed fields on the Primo request forms, you must have one of the following roles:

- General System Administrator
- Fulfillment Administrator
Non-mandatory fields on the Primo request forms may now be hidden from the patron’s view. Each of the three forms below, hold request, booking request, and digitization request, have their own customization table with the field names listed. All fields except the general use label field initially default to Yes, making them visible on the form. For the digitization request form, the default for the Partial field may also be customized using the uresolver_partial_digitization_default_value parameter on the Other Settings page so that Partial may be set to True and then hidden. This would be done if the library wants to restrict patron digitization requests to only partial digitization requests. For information on customizing this parameter, see Configuring Other Settings.

The general use label is hidden by default. It is a new field that has been added to the forms as a display field to give information to the patrons. The text of the general use label can be configured, as seen in the Configuring Labels section above.

To customize the visible fields on the Primo request forms:

1. All three tables are accessed from the Fulfillment > Fulfillment Configuration > Configuration Menu > Discovery Interface Display Logic menu. The page names are:
   - Hold Request Form Customization
   - Booking Request Form Customization
   - Digitization Request Form Customization

2. For each field to be changed, click Customize and then select the desired option from the Display to Public drop down box.

3. Click Save.

NOTE:

Mandatory fields such as the Pickup Location field cannot be hidden.
### Hold Request Form Customization

#### Table Information
- **Sub System**: FULFILLMENT
- **Table Name**: Mashup Hold Request Form
- **Table Description**: Define what fields to display/hide in GetIt hold request form

#### Mapping Table Rows

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Display to Public</th>
<th>Customize</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 comment</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>2 generalUseLabel</td>
<td>No</td>
<td>Customize</td>
</tr>
<tr>
<td>3 materialType</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>4 notNeededAfter</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>5 termsOfUse</td>
<td>Yes</td>
<td>Customize</td>
</tr>
</tbody>
</table>
### Booking Request Form Customization

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Display to Public</th>
<th>Customize</th>
</tr>
</thead>
<tbody>
<tr>
<td>checkAvailability</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>comment</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>generalUseLabel</td>
<td>No</td>
<td>Customize</td>
</tr>
<tr>
<td>materialType</td>
<td>Yes</td>
<td>Customize</td>
</tr>
</tbody>
</table>

**Table Description:** Define what fields to display/hide in Getit booking request form.
### Digitization Request Form Customization

#### Mapping Table

You are configuring: QA - Provisioning

<table>
<thead>
<tr>
<th>Sub System</th>
<th>Table Name</th>
<th>Last Updated</th>
<th>Table Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>FULFILLMENT</td>
<td>Mashup Digitization Request Form</td>
<td>-</td>
<td>Define what fields to display/hide in Getit digitization request form</td>
</tr>
</tbody>
</table>

#### Mapping Table Rows

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Display to Public</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>chapterArticleAuthor</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>chapterArticleTitle</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>comment</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>endPage</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>fullChapter</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>generalUseLabel</td>
<td>No</td>
<td>Customize</td>
</tr>
<tr>
<td>notNeededAfter</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>partial</td>
<td>Yes</td>
<td>Customize</td>
</tr>
<tr>
<td>startPage</td>
<td>Yes</td>
<td>Customize</td>
</tr>
</tbody>
</table>
Creating a Request from the Institution

A Circulation Desk Operator/Manager creates a request by searching the repository for titles or items in the institution (see Searching the Repository), and then doing one of the following:

- Creating a request for a title
- Creating a request for an item

For details on creating a request for a title or item, see Creating a Request.

You can also create a work order request, as needed (see Creating a Work Order Request).

You can move requests from one circulation desk to another using the Transfer Requests option (see Transfer Requests).

Creating a Request

**PERMISSIONS:** To create a request, you must have the following role:

- Fulfillment Services Operator

After locating a specific title or item in the institution’s repository, you can create a request for it.

**NOTE:**

- The type of request that you can create, and its limitations, depend on whether the title/item is physical or electronic, whether the titles have holdings and if these are monograph or serial, and the policies of the item (see Configuring Item Policies), the fulfillment unit that will service the request (see Configuring Policies), and the institution (see Configuring Terms of Use).

- A patron may be blocked from borrowing items (see Blocking Users).

- You can request an item belonging to a bibliographic record for which an item is already on loan to the requesting patron. To do so, ensure that the `enable_request_during_loan_for_different_policy` value is `true` in the Customer Parameters Mapping Table (see Configuring Other Settings).

For item-level requests and title-level requests with only one item, Alma can be configured to mark the requested item as not available. The item being requested will be marked as **Item not Available** and will have a **Process**
status of Requested. In such cases, if you release or cancel the request, the item’s Status becomes Item in Place. To enable this functionality, contact Ex Libris Support.

For the list of resource requests, see Request Status.

To create a request:

1. For physical items, click Request underneath a title/item on the Repository Search page (see Searching the Repository). For electronic titles/items, click Document Delivery. The Create Request page appears.

2. From the Request type drop-down list, select the type of request.
   - Booking request - Reserve resources for a patron during a specified time frame. For details on creating a booking request, see Creating Booking Requests.
   - Move permanently / Move temporarily - Permanently or temporarily change the location of a physical title or item. The To drop-down list appears, enabling you to select a library.

   For additional fields in this area, see step 3.

   When moving a title, all items associated with the title are moved.
Patron digitization request / Patron Electronic Digitization Request - Create a digital copy (in full or in part) of a physical/electronic title or item on behalf of a patron. The Requester and Managing Department drop-down lists appear, enabling you to select the patron and the digitization department.

New for May! Select Copyright Declaration Signed by Patron to indicate that the patron selected his or her agreement with the copyright when submitting the request.

For an article, additional fields are described in step 3.

The digitization request generates a temporary move request to move the item to the digitization department. After digitizing, another request is generated to return the item to its permanent location.

Patron Digitization Request for an Article

If you select Partial Digitization in the Add Request Attributes area (see step 4), the Notes field becomes Part to Digitize and the fields Chapter/Article Title, Chapter/Article Author, Start Page, End Page, and Full Chapter appear below this.

For additional fields in this area, see step 3.

Patron physical item request - Create a request to loan a physical title or item to a patron. The Requester and Pickup At drop-down lists appear, enabling you to select the patron and the destination for pickup.
Physical Item Request

**NOTE:** The **Pickup At** field includes the locations specified in the Borrowing Terms of Use by the Pick Up Location policy.

Click **Override ‘On Shelf Request Policy’** to override the configured fulfillment policy that determines where you can pick up resources. This enables you to request any pickup location.

For title-level requests, Alma chooses an appropriate item based on the following criteria:

- All items must be available in the repository.
- When multiple items in the same location are located for a request, an item is chosen randomly.
- By default, a remote storage facility item receives the lowest priority to fulfill the request. In these cases, a request is registered on a remote storage item only if no other item is found.

You can configure remote storage locations to take priority over non-remote storage locations by selecting the **Prefer over other locations** setting when configuring remote storage locations (see [Adding a Remote Storage Facility](#)).

- An item whose location is the same as the request’s pickup location receives the highest priority to fulfill the request.

You can enable a physical item request to be delivered to a user’s home or office. For details, see [Creating Personal Delivery Requests](#).
For additional fields in this area, see step 3, below.

- **Staff Digitization Request / Staff Electronic Digitization Request / Library physical digitization request** - Create a digital copy (in full or in part) of a physical title or item on behalf of a staff member. The staff member’s request may be the result of a request by an instructor. The **Managing Department** drop-down list appears, enabling you to select a digitization department that receives the digitization request.

  The digitization request generates a temporary move request to move the item to the digitization department. After digitizing, another request is generated to return the item to its permanent location.

  If you select **Partial Digitization** in the **Add Request Attributes** area, the fields **Chapter/Article Title**, **Chapter/Article Author**, **Start Page**, **End Page**, and **Full Chapter** appear below the **Note** field.

**New for May!** In addition, several fields appear in the **Copyright Attributes** section. These fields are used to record intended usage information. If copyright approval is required by the digitization rules, an approval task appears on the Approval Requests List page; see **Digitization Processing**. Fill in the fields:

- **Number of Students**
- **Number of Copies for Students**
- **Number of Copies for Staff**
- **Resource Total Pages**
- **Required Chapters**
- **Total Chapters Count**
- **Required Pages** – The **From** and **To** pages that will be digitized.
- **Source** (CLA-enabled institutions only) - For CLA-enabled institutions in the UK, select one of the following values:
  - **A** - From Paper original owned by institution
  - **B** - From Digital original licensed to institution
  - **C** - From copyright fee paid copy
  - **D** - From another HEI under Shared Provision

  To enable CLA, set **display_CLA_info_in_alma** to **true**, see **Configuring Other Settings**.

- **Date Available To** – The date until which any copies will be made available.
- **Note 1/2/3** – Private notes, if any.
Staff Digitization Request

- General Hold Request - Appears only when placing a request for a holding that contains no items. For details on creating a general hold request, see Creating a General Hold Request.

3. The following additional fields may appear:

- Enter any notes in the Notes field.

The remaining fields in this step appear only for physical serial items, or for physical titles that contain at least one serial item.

- Select one of the following radio buttons:
  - **Description** – Use the description that appears in the Description field, below.
  - **Manual** – Enter a manual description in the Manual Description field, below.

These buttons appear when there are no items associated with the title. In this case, Manual is assumed.

If you select Description, the following fields appear:

- **Year** – Year for the request.
- **Volume** – Volume for the request.

- **Description** – The descriptions of the items. The option **All** appears if you did not select both **Year** and **Volume** and there are items without descriptions. Select **All** to indicate all items (including those without descriptions).

If you select **Manual**, or if the title has associated holdings but no items, the following fields appear:

- **Holding** – Select a holding for the item. See [Creating a Non-Cataloged Serial Item Request](#).

- **Manual Description** – Enter a description. See [Creating a Non-Cataloged Serial Item Request](#).

For holdings in remote storage, if the **Allow Manual Description Requests** option has been disabled on the configuration for the remote storage facility, selecting **Manual** will cause the holdings in remote storage to be suppressed from the available items for this request. See [Configuring Remote Storage Facilities](#).

4. Add request attributes in the **Add Request Attributes** area. After selecting each attribute and its corresponding value, click **Add Request Attribute**. The attribute appears in the **Additional Request Attributes** area. The available attributes depend on the selected **Request Type**:

<table>
<thead>
<tr>
<th>Request Type</th>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Booking Request</td>
<td></td>
<td>See <a href="#">Creating Booking Requests</a></td>
</tr>
<tr>
<td>Move Permanently or Move Temporarily</td>
<td>Number of Copies</td>
<td>The number of copies requested</td>
</tr>
<tr>
<td></td>
<td>Destination Locations</td>
<td>Where to deliver the copies</td>
</tr>
<tr>
<td></td>
<td>Due Back</td>
<td>When the items are due back</td>
</tr>
<tr>
<td></td>
<td>For <strong>Move Temporarily</strong> only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Call Number Type</td>
<td>See <strong>call_number_type</strong> in <a href="#">Configuring Other Settings</a></td>
</tr>
<tr>
<td></td>
<td>Call Number</td>
<td>The call number</td>
</tr>
<tr>
<td></td>
<td>Item Policy</td>
<td>The item’s override policy for loan rules. For more information, see <a href="#">Configuring Item Policies</a></td>
</tr>
<tr>
<td>Request Type</td>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Patron Digitization Request / Patron Electronic Digitization Request / Staff Digitization Request / Staff Electronic Digitization Request / Library physical digitization request</td>
<td>Partial Digitization</td>
<td>Select to indicate that the request is for only part of the item, not the entire item. After you click Add Request Attribute, the fields Chapter/Article Title, Chapter/Article Author, Start Page, End Page, and Full Chapter are added to the Create Request area above.</td>
</tr>
<tr>
<td></td>
<td>Material Type Not available for Patron Electronic Digitization Request</td>
<td>Select the desired material type from the available types.</td>
</tr>
<tr>
<td></td>
<td>Date Needed By</td>
<td>Select the date that the request is needed from the calendar tool.</td>
</tr>
<tr>
<td>Patron Physical Item Request</td>
<td>Material Type</td>
<td>Select the desired material type from the available types.</td>
</tr>
<tr>
<td></td>
<td>Date Needed By</td>
<td>Select the date that the request is needed by from the calendar tool.</td>
</tr>
<tr>
<td></td>
<td>Loan Period</td>
<td>The amount of time the user has before having to return the item.</td>
</tr>
<tr>
<td>General Hold Request</td>
<td>See Creating a General Hold Request.</td>
<td></td>
</tr>
</tbody>
</table>

To remove an attribute, click Remove in the Additional Request Attributes area.

5. Click Submit. The request is created with a unique identification number and processed (see Resource Requests). A completed request appears on the Resource Request Monitoring page with the following information:

- **Workflow Step**: Pickup from shelf
- **Process Status**: New
- **Managed by Library**: The library where the available inventory is located

Ex Libris, a ProQuest Company
Managed by Desk: The circulation desk where the available inventory is located

A patron receives notification that an item is ready for pickup from the hold shelf after the Hold Shelf Processing status is complete.

For details on the resource request workflow, see Resource Requests Workflow.

For a digitization request, the request appears on the In Process Items page (see Digitizing Items). For more information, see Digitization Processing.

Creating a Work Order Request

PERMISSIONS: To create a request, you must have the following role:

- Fulfillment Services Operator

A work order indicates that a process needs to be run on a physical item. Work order types are created on the Work Order Types page, accessible from the General Configuration menu (see Configuring Work Order Types).

You can monitor the progress of work orders on the Resource Request Monitoring page (Fulfillment > Resource Requests > Monitor Requests & Item Processes).

To create a work order request:

1. Click Work Order underneath an item displayed from a physical items search on the Repository Search page. The Work Order option appears only when searching the repository for physical items.

   The Place Item in Process page opens.

   ![Place Item in Process Page](image-url)
Managing Citations

**PERMISSIONS:** To manage a citations, you must have one of the following roles:

- Fulfillment Services Operator
- Fulfillment Services Manager

Citations can be for books or articles, in either electronic or physical format, and must supply sufficient detail to uniquely identify the item. This includes author(s), date of publication, title, and page numbers. You can also use unique identifiers such as the International Standard Book Number (ISBN), a URL for a website, or specific volumes, articles, or other identifiable parts of a periodical.

**NOTE:**

- Since book chapters, journal articles, and conference papers are parts of larger documents, their titles may be different than the title of the entire document. Similarly, the authors may be different from the author or editor of the entire document. Their citations include details regarding the sources in which they appear.

- Citations added using the Alma UI or the Alma Web service API are added to the default section of a reading list.

- Citations that are linked to active courses are published to Primo with course information included. The following can be retrieved by a Primo search: course IDs, course names, and instructor names. Note that for this information to be published to Primo, the **Course information enrichment** check box must be selected in the Primo publishing profile.

Citations can be linked to the repository/inventory items or not. Titles not linked to the repository are typically faculty resources that are not part of the institution’s inventory.

You manage reading list citations on the Citations tab of the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list or select Actions > Work on).
Edit Reading List Page – Citation Action Areas

Actions available to manage citations are available in several groups:

- You can filter the list of citations using the filters.
- To manage one or more existing citations, select the check boxes next to the desired citations, or select the Select All check box, and then click one of the buttons on the top or bottom of the page.
- To manage a single existing citation, click one of the action links beneath the citation.
- To add a citation, duplicate an existing citation or click one of the Add buttons at the top of the list of citations (beneath the citation list filters):
  - Add Repository Citation adds a citation and connects it to an item in the repository
  - Add Non-Repository Citation adds a citation that is not in the repository
  - Add Brief adds an item to the repository, and then adds a citation that is connected to it

After making any changes, click Save to save the changes and return to the Reading Lists Tasks List page.

The available actions to manage citations on this page are as follows:

### Managing Citations Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a citation</td>
<td>See Adding Citations to a Reading List.</td>
</tr>
<tr>
<td>Action</td>
<td>Procedure</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To view additional information about a citation, click More Info beneath a citation. A pop-up window displays additional information about the citation. You can click links in the pop-up window to view a citation’s related inventory and related courses.</td>
<td></td>
</tr>
<tr>
<td>To view a citation’s items or portfolios, click Items or Portfolio List beneath the citation. The List of Items or Portfolios List page appears. For more information about the List of Items page, see Using the List of Items. For more information about the Portfolios List page, see Using the Portfolio List.</td>
<td></td>
</tr>
</tbody>
</table>

**New for May!**

- To view the original source of a citation added using Leganto Cite It, click View Source. This link appears if Source is defined for the citation.
- For an article, to view the OpenURL link resolver results of an article, click View It. This link appears if the link resolved found at least one matched resource.
- For CLA-enabled institutions in the UK, to view a popup with copyright information about the citation retrieved from the CLA, click Check CLA Permissions. A popup with the information appears. Select the type of work you intend to perform in the dropdown at the top of the popup.
Action Procedure

Check CLA Permissions

To enable CLA, set `display_CLA_info_in_alma` to true, see Configuring Other Settings.
<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing a citation</td>
<td>You can edit a citation, for example to improve its metadata.</td>
</tr>
<tr>
<td></td>
<td>To edit a citation, click <strong>Edit</strong> beneath a citation. The Edit Reading List Citation page appears. Modify the information in the <strong>Citation</strong> tab as required and click <strong>Save</strong>. For information on the fields in the <strong>Citation</strong> tab, see <a href="#">Adding Citations to a Reading List</a>.</td>
</tr>
<tr>
<td></td>
<td>To add or edit citation notes, click the <strong>Notes</strong> tab, add, edit, or delete notes as required, and click <strong>Save</strong>.</td>
</tr>
<tr>
<td></td>
<td>To add or edit citation tags, click the <strong>Tags</strong> tab, add or delete tags as required, and click <strong>Save</strong>. You can filter using these tags on the Edit Reading List page.</td>
</tr>
<tr>
<td>Managing a citation's attachment to an inventory item</td>
<td>See <a href="#">Managing a Citation's Attachment to an Inventory Item</a>.</td>
</tr>
<tr>
<td>Managing a citation's fulfillment options</td>
<td>See <a href="#">Managing Citation Fulfillment Options</a>.</td>
</tr>
<tr>
<td>Attaching citation attributes to a citation</td>
<td>See <a href="#">Attaching Citation Attributes to Citations</a>. Also see Editing a citation above for adding tags to a citation.</td>
</tr>
<tr>
<td>Printing slips for citations</td>
<td>See <a href="#">Printing Slips for Citations or Generating a Citation Print Slip Report</a>.</td>
</tr>
<tr>
<td>Changing a citation's status</td>
<td>Changing a citation status does not change the reading list status, and vice versa.</td>
</tr>
<tr>
<td></td>
<td>To change citation statuses, select the citations, select the status from the drop down to the left of the <strong>Change Status</strong> button at the top or bottom of the page, and click <strong>Change Status</strong>.</td>
</tr>
<tr>
<td></td>
<td>Alternately, to set a citation’s status to complete, click <strong>Set Complete</strong> beneath the citation.</td>
</tr>
<tr>
<td></td>
<td>The available statuses are the same as those for the reading list itself. See <a href="#">Adding a Reading List</a>. For information on configuring citation statuses, see <a href="#">Configuring Reading List Citation Statuses</a>.</td>
</tr>
<tr>
<td>Changing a citation’s copyright status</td>
<td>The copyright status field is purely for informational purposes, to inform the reading list owners about whether copyright issues for the citations are approved or not. To change the copyright status of citations, select the citations and click <strong>Change Copyright Status</strong>, select the status in the Change Copyright Status pop-up that appears, and click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Action</td>
<td>Procedure</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Creating requests for citations** | If you can place requests on one or more citations in order to move the items (permanently or temporarily) or to digitize them. You might place a bulk move request if, for example, the reading list's due-back date changes. To create a bulk requests, select the citations and click **Place Request**. The Create Request page appears (see [Create Request Page](#)). Select a request type, fill in the remaining fields (as described in [Creating a Request](#)) and click **Submit**. The requests are:  
- **Library physical digitization request**  
- **Move permanently**  
- **Move temporarily**  
  To create a patron purchase request for a citation, click **Purchase Request** beneath a citation. For more information see [Patron Purchase Requests](#). |
| Removing alerts from citations | If the inventory items are geographically far and/or you have no access to the shelves on which they are located, use the fulfillment options to place and then view requests. (See [To manage fulfillment options for a resource](#)) |
### Action Procedure

In this case, for each step in the citation request workflow, an alert is generated – for example, **Citation Digitization Request In Process, Citation Digitization Request Completed**. You can use the **Alerts** filter to monitor the status of physical items that you have requested to move to reserved areas or material that you have requested in digital format. For example, you can use the **Alerts** filter to view only those citations whose request processing has been completed (in order to mark their status as **Complete**).

To remove all alerts from citations, select the citations and click **Remove Alerts**.

<table>
<thead>
<tr>
<th>Removing citations</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the citations and click <strong>Remove Citations</strong>. Click <strong>Confirm</strong> in the confirmation dialog box. Alternately, click <strong>Remove</strong> beneath the citation.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Adding Citations to a Reading List**

Add a citation using one of the three workflows or by duplicating an existing citation and editing the copy.

**NOTE:** You can also create a citation by scanning in an item and selecting the appropriate reading list in the **Change Item Information** tab. The item is added as a citation to the selected reading list. For details on the **Change Item Information** tab, see **Changing Item Information**.

To add a citation already in the repository:

1. On the **Edit Reading List** page (**Fulfillment > Course Reserves > Reading Lists**; click the reading list) in the **Citations** tab, click **Add Repository Citation**. The Repository Search page appears.

![Repository Search Page](image)

2. Enter the search criteria and click **Go**. You must select one of the titles values in the **Find** box (**All titles, Physical titles, Electronic titles, or Digital titles**). The Repository Search page displays records that match the search criteria. For more information on the Repository Search, see **Using the Repository Search**.

3. Select the citation item you want to add, and click **Select**. The new citation appears in the **Citations** tab of the **Edit Reading List** page.

To add copyright clearance information or to configure other citation information (see **To add a citation that is not in the repository (without adding it to the repository)**), you must edit the citation after adding it. To edit the citation, click **Edit** beneath the citation on the Reading List page.

---

Ex Libris, a ProQuest Company
To add a citation that is not in the repository (without adding it to the repository):

1. On the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab, click Add Non-Repository Citation. A dialog box appears.

2. In Citation type, select the type of citation: Click Choose. The Edit Reading List Citation page (for non-repository citations) appears, containing the fields for the selected citation type (see the following images).

```
Edit Reading List Citation Page (for non-repository citations) for a Book
```

Ex Libris, a ProQuest Company
### Edit Reading List Citation Page (for non-repository citations) for an Article

<table>
<thead>
<tr>
<th>Resource Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Article/Chapter Title</strong></td>
</tr>
<tr>
<td><strong>Journal Title</strong></td>
</tr>
<tr>
<td><strong>Author</strong></td>
</tr>
<tr>
<td><strong>Volume</strong></td>
</tr>
<tr>
<td><strong>Author Initials</strong></td>
</tr>
<tr>
<td><strong>Issue</strong></td>
</tr>
<tr>
<td><strong>ISBN</strong></td>
</tr>
<tr>
<td><strong>LCCN</strong></td>
</tr>
<tr>
<td><strong>OCLC Number</strong></td>
</tr>
<tr>
<td><strong>Other Standard ID</strong></td>
</tr>
<tr>
<td><strong>Barcode</strong></td>
</tr>
<tr>
<td><strong>Remote Record ID</strong></td>
</tr>
<tr>
<td><strong>DOI</strong></td>
</tr>
<tr>
<td><strong>PMID</strong></td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td><strong>Place of Publication</strong></td>
</tr>
<tr>
<td><strong>Additional Person Name</strong></td>
</tr>
<tr>
<td><strong>Source</strong></td>
</tr>
<tr>
<td><strong>Series Title Number</strong></td>
</tr>
<tr>
<td><strong>Note</strong></td>
</tr>
<tr>
<td><strong>Chapter</strong></td>
</tr>
<tr>
<td><strong>Pages</strong></td>
</tr>
<tr>
<td><strong>Start Page</strong></td>
</tr>
<tr>
<td><strong>End Page</strong></td>
</tr>
<tr>
<td><strong>Publication Date</strong></td>
</tr>
</tbody>
</table>
3. In the **Resource Information** area, enter the necessary information in the fields. A description of the fields appears in the [Resource Information Fields](#) table.

4. **New for May!** In the **Copyright Attributes** area, select **Copyright Auditing Required** to add intended usage information. When selected, fill in the additional fields that appear. For information on these fields, see [Creating a Request](#).

5. In the **Citation Parameters** area, optionally select:
- **New for May!** [Disable Resolving](Leganto customers only) - Whether to prevent Leganto from displaying OpenURL links for the resource. See [Managing a Citation's Attachment to an Inventory Item](Managing a Citation's Attachment to an Inventory Item). You can turn off link resolving for all article citations using a customer parameter; see [Configuring Repository Search in Leganto](Configuring Repository Search in Leganto).

- **Copyright Status** - For more information, see Changing a citation’s copyright status, above

- **Material Type** - Select an available option.

- **New for May!** [Public Note](Leganto customers only; edit only) - Edit a public note that appears in Leganto, if relevant.

6. Click **Save** or **Save and Manage Approval**. The new citation appears on the Edit Reading List page.

   Alma checks if a single inventory item matches the citation, and if so the citation is automatically linked to that inventory item. You can click **Detach from Repository** to remove this attachment. See [Managing a Citation's Attachment to an Inventory Item](Managing a Citation's Attachment to an Inventory Item).

- **New for May!** If you click **Save and Manage Approval**, the Approval Requests List appears. For more information, see [Approving/Rejecting a Request for Digitization](Approving/Rejecting a Request for Digitization).

7. Optionally click **Resource locate** on the Edit Reading List page to locate a resource for the new citation. For more information, see [Managing Citation Fulfillment Options](Managing Citation Fulfillment Options).

**To add a citation that is not in the repository and also add it to the repository:**

1. On the Edit Reading List page ([Fulfillment > Course Reserves > Reading Lists](Fulfillment > Course Reserves > Reading Lists); click the reading list) in the **Citations** tab, click **Add Brief**.

2. In the dialog box that appears, select the type of citation you want to create—physical book/article or electronic book/article—and click **Choose**. The Quick Cataloging page appears.
3. Configure resource and item information (for information on the fields, see Adding a New Book or Journal Article). In the Citation Parameters area, optionally select the Copyright Status (for more information, see Changing a citation’s copyright status in the above table) and Material Type from the available options.

4. Click Save. New inventory is created and the new citation appears in the Citations tab of the Edit Reading List page.

To add copyright clearance information or to configure other citation information (see To add a citation that is not in the repository (without adding it to the repository), you must edit the citation after adding it. To edit the citation, click Edit beneath the citation on the Reading List page.

**NOTE:** The course_restricted_bib_date_will_be_deleted parameter (see Configuring Other Settings) determines whether the published course data created in this process is deleted (true) or suppressed (false, by default) from Primo when the course becomes inactive.

If you have enabled the RFID integration profile (see RFID Support), you can click Write to RFID and Save to save the new inventory to RFID.

---

To add a citation by duplicating an exiting citation:

On the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab, click Duplicate beneath a citation. The Edit Reading List Citation page appears. Modify the parameters as needed and save the new citation. See the above add procedures for details.

---

Managing a Citation's Attachment to an Inventory Item

When you create a citation, you can create it attached to an already existing inventory item, or you can create the inventory item at the same time and have the citation attached to the new inventory item.

To remove this attachment, click Detach from Repository beneath a citation. After performing this action, the citation is not connected to any inventory. (If you are using Leganto, to prevent Leganto from displaying OpenURL links - but not actually detach the citation from the inventory - edit the citation and select Disable Resolving.)

When you create a citation without any attachment to an inventory item, Alma tries to locate a matching inventory item. If a single item is discovered, Alma automatically attaches the citation to the inventory item. For more information, see Configuring Citation Matching Criteria.

If you have detached the citation from an inventory item, or the inventory could not be located automatically, you can try to attach the citation to an inventory item manually.

**To locate a resource manually:**

Click the Resource Locate link beneath a citation. Alma attempts to locate inventory that matches the citation and if a single inventory match (in any format) is found, Alma attaches it automatically.
If Alma could find no matches, Alma displays a screen allowing you to edit the search criteria. If Alma finds multiple matches, Alma displays a screen enabling you to select one of the matches or edit your search criteria. For more information, see Searching in the Repository.

---

Managing Citation Fulfillment Options

To check how the citation can be made available to students, on the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab, click Manage Fulfillment Options links beneath the citation.

- If the inventory items are geographically far and/or you have no access to the shelves on which they are located, use the fulfillment options to place and then view requests. (see below.)

  In this case, for each step in the citation request workflow, an alert is generated — for example, Citation Digitization Request In Process, Citation Digitization Request Completed. You can use the Alerts filter to monitor the status of physical items that you have requested to move to reserved areas or material that you have requested in digital format. For example, you can use the Alerts filter to view only those citations whose request processing has been completed (in order to mark their status as Complete). To remove the alerts, see Removing alerts from citations in the above table.

- If the inventory items are geographically nearby and/or you have access to them, you can fetch the items from the shelves by clicking the Print slip link beneath a citation to print a slip for the specific citation. Use the Change Item Information tab to temporarily change the item location, as described in Changing Item Information.

- If the item is not in your library’s inventory, or if you would like the library to purchase additional copies, consider making a patron purchase request by clicking Purchase Request beneath the citation. For more information, see Patron Purchase Requests.

To manage fulfillment options for a resource:

Click the Manage Fulfillment Options link below the citation. The Manage Resource Options page appears.

The link is available only if a resource was specified.
The following fields appear on this page:

Manage Resource Options Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td></td>
</tr>
<tr>
<td>Author</td>
<td></td>
</tr>
<tr>
<td>ISBN (or ISSN)</td>
<td></td>
</tr>
<tr>
<td>Place of Publication</td>
<td></td>
</tr>
<tr>
<td>Chapter</td>
<td></td>
</tr>
<tr>
<td>Pages</td>
<td></td>
</tr>
<tr>
<td>Additional Person Name</td>
<td>An additional contact, if any</td>
</tr>
<tr>
<td>Year</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edition</td>
<td></td>
</tr>
<tr>
<td>Call Number</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>A public note, if any</td>
</tr>
<tr>
<td>Alerts</td>
<td>Any alerts on the citation, if any</td>
</tr>
<tr>
<td><strong>Course Details</strong></td>
<td></td>
</tr>
<tr>
<td>Course Code</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>The course section</td>
</tr>
<tr>
<td>Course Name</td>
<td></td>
</tr>
<tr>
<td>Number of Participants</td>
<td>The number of participants in this course</td>
</tr>
<tr>
<td>Reading List Name</td>
<td></td>
</tr>
<tr>
<td>Demand for X courses with overall Y</td>
<td>The number of participants in all courses in which this citation appears</td>
</tr>
<tr>
<td>participants</td>
<td></td>
</tr>
<tr>
<td><strong>Electronic Services – Electronic</strong></td>
<td><strong>fulfillment information for the citation</strong></td>
</tr>
<tr>
<td>Digital Services – Digital**</td>
<td><strong>fulfillment information for the citation</strong></td>
</tr>
<tr>
<td>Physical Services – Physical**</td>
<td><strong>fulfillment information for this citation. Available actions for each</strong></td>
</tr>
<tr>
<td><strong>location include View Items, Request,</strong></td>
<td><strong>and Update Move Expiry. See below the table for details.</strong></td>
</tr>
<tr>
<td><strong>and Update Move Expiry. See below the</strong></td>
<td><strong>table for details.</strong></td>
</tr>
<tr>
<td><strong>table for details.</strong></td>
<td></td>
</tr>
<tr>
<td>This Record in Other Lists – Information</td>
<td><strong>about the citation as it appears in other reading lists. Available</strong></td>
</tr>
<tr>
<td><strong>actions for each location include View</strong></td>
<td><strong>and Place Request. See below the table for details. For each other</strong></td>
</tr>
<tr>
<td><strong>Items, Request, and Update Move</strong></td>
<td><strong>reading list, the following fields appear for the citation:</strong></td>
</tr>
<tr>
<td><strong>expiry. See below the table for</strong></td>
<td><strong>details.</strong></td>
</tr>
<tr>
<td><strong>details.</strong></td>
<td></td>
</tr>
<tr>
<td>Course Code</td>
<td>Course code of the other reading list</td>
</tr>
<tr>
<td>Course Name</td>
<td></td>
</tr>
<tr>
<td>Section Id</td>
<td>The course section</td>
</tr>
<tr>
<td>Academic Department</td>
<td></td>
</tr>
<tr>
<td>Processing Department</td>
<td></td>
</tr>
<tr>
<td>Instructor</td>
<td>The instructor who created the reading list</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date for this course</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Date</td>
<td>The end date for this course</td>
</tr>
<tr>
<td>Number of Participants</td>
<td>The number of participants in this course</td>
</tr>
<tr>
<td>Reading List Name</td>
<td></td>
</tr>
<tr>
<td>Reading List Status</td>
<td></td>
</tr>
<tr>
<td>Section Name</td>
<td>The reading list section</td>
</tr>
<tr>
<td>Citation Status</td>
<td></td>
</tr>
</tbody>
</table>

At the bottom of the page you can view existing requests for this citation. Some requests are specific to a reading list. Select the reading list from Filter Requests By Records in Other Lists to view only requests for that reading list. For more information about the fields and actions in this section, see Managing Requests and Work Orders.

The following actions are available for physical services:

- **View items** – Select **Actions > View items**. The List of Items page appears.

![List of Items Page](image)

**List of Items Page**

For more information about the List of Items page, see Using the List of Items.

- **Create a request** – Select **Actions > Request**, or click **Place Request**. The Create Request page appears (see Create Request Page). Select a request type (as described in Creating a Request) and click **Submit**.

- **Update the item’s due back date so that it matches the due back date of the reading list (when the reading list’s due back date is later than that of the item)** – Select **Actions > Update move expiry**.

The following actions are available for citations that also appear in other reading lists:

- **View the other reading list** – Select **Actions > View**. The other reading list appears.

- **Create a request for the other reading list** – Select **Actions > Place Request**. The Create Request page appears (see Create Request Page). Select a request type (as described in Creating a Request) and click **Submit**.
Attaching Citation Attributes to Citations

To configure the available citation attributes, see Configuring Citation Attribute Types, Configuring Citation Attributes, and Mapping Citation Attributes to Citation Attributes Types.

To attach citation attributes to citations:

1. On the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab, click Edit beneath a citation. The Edit Reading List Citation page appears.
2. In the Quick Add section at the bottom of the Citation tab, select a citation attribute type and the citation attribute you want to map, and click Add Citation Attribute. The selected values appear in a table at the bottom of the page.
3. Click Save. The added citation attribute appears in the reading list information on the Edit Reading List page.

Printing Slips for Citations or Generating a Citation Print Slip Report

If the inventory items are geographically nearby and/or you have access to them, you can fetch the items from the shelves by printing a slip for the citations. On the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab:

- Click Print Slip beneath a citation
- Select one or more citations and click Print Slip at the top or bottom of the page. A print slip is generated for each citation.
For information about the print slip, see the Ful Citation Slip Letter in Configuring Alma Letters.

You can also generate a print slip report that is sent to a printer or email address, or can be downloaded to a local machine. The report is an Excel file that contains the citations and their information, including Title, Author, Location, Call Number, ISBN/ISSN, Edition, Imprint, Availability, Electronic Availability, and Digital Availability.

To generate an Excel print slip report for citations:

1. On the Edit Reading List page (Fulfillment > Course Reserves > Reading Lists; click the reading list) in the Citations tab, select the citations and click Print Slip Report. The Print Slip Report dialog box appears.

2. Select whether to send the report by email (Email or User) or to a printer (Printer).

3. Select the destination:
- If sending by email, enter the email address in the Email field or the Alma user in the User field.
- If sending to the printer, select the printer in the Printer field.

4. Optionally download the report by clicking Download.
5. To send the report to the selected destination, click Send.